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Palo Alto Networks XDR-Analyst Exam Syllabus Topics:

Topic Details

Topic 1
Alerting and Detection Processes: This domain covers identifying alert types and sources, prioritizing alerts
through scoring and custom configurations, creating incidents, and grouping alerts with data stitching
techniques.

Topic 2 Endpoint Security Management:

Topic 3
Incident Handling and Response: This domain focuses on investigating alerts using forensics, causality
chains and timelines, analyzing security incidents, executing response actions including automated
remediation, and managing exclusions.

Topic 4
This domain addresses managing endpoint prevention profiles and policies, validating agent operational
states, and assessing the impact of agent versions and content updates.

Topic 5
Data Analysis: This domain encompasses querying data with XQL language, utilizing query templates and
libraries, working with lookup tables, hunting for IOCs, using Cortex XDR dashboards, and understanding
data retention and Host Insights.
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Analyst updated exam questions. The Palo Alto Networks XDR-Analyst exam dumps are being offered at affordable charges. We
guarantee you that the XDR-Analyst Exam Dumps prices are entirely affordable for every XDR-Analyst exam candidate.

Palo Alto Networks XDR Analyst Sample Questions (Q62-Q67):
NEW QUESTION # 62 
Which of the following paths will successfully activate Remediation Suggestions?

A. Alerts Table > Right-click on a process node > Remediation Suggestions
B. Incident View > Actions > Remediation Suggestions
C. Causality View > Actions > Remediation Suggestions
D. Alerts Table > Right-click on an alert > Remediation Suggestions

Answer: C

Explanation:
Remediation Suggestions is a feature of Cortex XDR that provides you with recommended actions to remediate the root cause and
impact of an incident. Remediation Suggestions are based on the analysis of the causality chain, the behavior of the malicious files or
processes, and the best practices for incident response. Remediation Suggestions can help you to quickly and effectively contain and
resolve an incident, as well as prevent future recurrence.
To activate Remediation Suggestions, you need to follow these steps:
In the Cortex XDR management console, go to Incidents and select an incident that you want to remediate.
Click Causality View to see the graphical representation of the causality chain of the incident.
Click Actions and select Remediation Suggestions. This will open a new window that shows the suggested actions for each node in
the causality chain.
Review the suggested actions and select the ones that you want to apply. You can also edit or delete the suggested actions, or add
your own custom actions.
Click Apply to execute the selected actions on the affected endpoints. You can also schedule the actions to run at a later time or
date.
Reference:
Remediate Changes from Malicious Activity: This document explains how to use Remediation Suggestions to remediate the root
cause and impact of an incident.
Causality View: This document describes how to use Causality View to investigate the causality chain of an incident.

NEW QUESTION # 63 
What is the purpose of the Cortex Data Lake?

A. the interface between firewalls and the Cortex XDR agents
B. a local storage facility where your logs and alert data can be aggregated
C. the workspace for your Cortex XDR agents to detonate potential malware files
D. a cloud-based storage facility where your firewall logs are stored

Answer: D

Explanation:
The purpose of the Cortex Data Lake is to provide a cloud-based storage facility where your firewall logs are stored. Cortex Data
Lake is a service that collects, transforms, and integrates your enterprise's security data to enable Palo Alto Networks solutions. It
powers AI and machine learning, detection accuracy, and app and service innovation. Cortex Data Lake automatically collects,
integrates, and normalizes data across your security infrastructure, including your next-generation firewalls, Prisma Access, and
Cortex XDR. With unified data, you can run advanced AI and machine learning to radically simplify security operations with apps
built on Cortex. Cortex Data Lake is available in multiple regions and supports data residency and privacy requirements. Reference:
Cortex Data Lake - Palo Alto Networks
Cortex Data Lake - Palo Alto Networks
Cortex Data Lake, the technology behind Cortex XDR - Palo Alto Networks CORTEX DATA LAKE - Palo Alto Networks
Sizing for Cortex Data Lake Storage - Palo Alto Networks
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NEW QUESTION # 64 
Which engine, of the following, in Cortex XDR determines the most relevant artifacts in each alert and aggregates all alerts related to
an event into an incident?

A. Causality Chain Engine
B. Sensor Engine
C. Causality Analysis Engine
D. Log Stitching Engine

Answer: C

Explanation:
The engine that determines the most relevant artifacts in each alert and aggregates all alerts related to an event into an incident is the
Causality Analysis Engine. The Causality Analysis Engine is one of the core components of Cortex XDR that performs advanced
analytics on the data collected from various sources, such as endpoints, networks, and clouds. The Causality Analysis Engine uses
machine learning and behavioral analysis to identify the root cause, the attack chain, and the impact of each alert. It also groups
related alerts into incidents based on the temporal and logical relationships among the alerts. The Causality Analysis Engine helps to
reduce the noise and complexity of alerts and incidents, and provides a clear and concise view of the attack story12.
Let's briefly discuss the other options to provide a comprehensive explanation:
A . Sensor Engine: This is not the correct answer. The Sensor Engine is not responsible for determining the most relevant artifacts in
each alert and aggregating all alerts related to an event into an incident. The Sensor Engine is the component that runs on the Cortex
XDR agents installed on the endpoints. The Sensor Engine collects and analyzes endpoint data, such as processes, files, registry
keys, network connections, and user activities. The Sensor Engine also enforces the endpoint security policies and performs
prevention and response actions3.
C . Log Stitching Engine: This is not the correct answer. The Log Stitching Engine is not responsible for determining the most
relevant artifacts in each alert and aggregating all alerts related to an event into an incident. The Log Stitching Engine is the
component that runs on the Cortex Data Lake, which is the cloud-based data storage and processing platform for Cortex XDR. The
Log Stitching Engine normalizes and stitches together the data from different sources, such as firewalls, proxies, endpoints, and
clouds. The Log Stitching Engine enables Cortex XDR to correlate and analyze data from multiple sources and provide a unified
view of the network activity and threat landscape4.
D . Causality Chain Engine: This is not the correct answer. Causality Chain Engine is not a valid name for any of the Cortex XDR
engines. There is no such engine in Cortex XDR that performs the function of determining the most relevant artifacts in each alert and
aggregating all alerts related to an event into an incident.
In conclusion, the Causality Analysis Engine is the engine that determines the most relevant artifacts in each alert and aggregates all
alerts related to an event into an incident. By using the Causality Analysis Engine, Cortex XDR can provide a comprehensive and
accurate detection and response capability for security analysts.
Reference:
Cortex XDR Pro Admin Guide: Causality Analysis Engine
Cortex XDR Pro Admin Guide: View Incident Details
Cortex XDR Pro Admin Guide: Sensor Engine
Cortex XDR Pro Admin Guide: Log Stitching Engine

NEW QUESTION # 65 
While working the alerts involved in a Cortex XDR incident, an analyst has found that every alert in this incident requires an
exclusion. What will the Cortex XDR console automatically do to this incident if all alerts contained have exclusions?

A. create a BIOC rule excluding this behavior
B. mark the incident as Resolved - False Positive
C. create an exception to prevent future false positives
D. mark the incident as Unresolved

Answer: B

Explanation:
If all alerts contained in a Cortex XDR incident have exclusions, the Cortex XDR console will automatically mark the incident as
Resolved - False Positive. This means that the incident was not a real threat, but a benign or legitimate activity that triggered an alert.
By marking the incident as Resolved - False Positive, the Cortex XDR console removes the incident from the list of unresolved
incidents and does not count it towards the incident statistics. This helps the analyst to focus on the true positive incidents that require
further investigation and response1.
An exclusion is a rule that hides an alert from the Cortex XDR console, based on certain criteria, such as the alert source, type,



severity, or description. An exclusion does not change the security policy or prevent the alert from firing, it only suppresses the alert
from the console. An exclusion is useful when the analyst wants to reduce the noise of false positive alerts that are not relevant or
important2.
An exception, on the other hand, is a rule that overrides the security policy and allows or blocks a process or file from running on an
endpoint, based on certain attributes, such as the file hash, path, name, or signer. An exception is useful when the analyst wants to
prevent false negative alerts that are caused by malicious or unwanted files or processes that are not detected by the security
policy3.
A BIOC rule is a rule that creates an alert based on a custom XQL query that defines a specific behavior of interest or concern. A
BIOC rule is useful when the analyst wants to detect and alert on anomalous or suspicious activities that are not covered by the
default Cortex XDR rules4.
Reference:
Palo Alto Networks Cortex XDR Documentation, Resolve an Incident1
Palo Alto Networks Cortex XDR Documentation, Alert Exclusions2
Palo Alto Networks Cortex XDR Documentation, Exceptions3
Palo Alto Networks Cortex XDR Documentation, BIOC Rules4

NEW QUESTION # 66 
In Windows and macOS you need to prevent the Cortex XDR Agent from blocking execution of a file based on the digital signer.
What is one way to add an exception for the singer?

A. In the Restrictions Profile, add the file name and path to the Executable Files allow list.
B. Create a new rule exception and use the singer as the characteristic.
C. Add the signer to the allow list under the action center page.
D. Add the signer to the allow list in the malware profile.

Answer: D

Explanation:
To prevent the Cortex XDR Agent from blocking execution of a file based on the digital signer in Windows and macOS, one way to
add an exception for the signer is to add the signer to the allow list in the malware profile. A malware profile is a profile that defines
the settings and actions for malware prevention and detection on the endpoints. A malware profile allows you to specify a list of files,
folders, or signers that you want to exclude from malware scanning and blocking. By adding the signer to the allow list in the
malware profile, you can prevent the Cortex XDR Agent from blocking any file that is signed by that signer1.
Let's briefly discuss the other options to provide a comprehensive explanation:
A . In the Restrictions Profile, add the file name and path to the Executable Files allow list: This is not the correct answer. Adding the
file name and path to the Executable Files allow list in the Restrictions Profile will not prevent the Cortex XDR Agent from blocking
execution of a file based on the digital signer. A Restrictions Profile is a profile that defines the settings and actions for restricting the
execution of files or processes on the endpoints. A Restrictions Profile allows you to specify a list of executable files that you want to
allow or block based on the file name and path. However, this method does not take into account the digital signer of the file, and it
may not be effective if the file name or path changes2.
B . Create a new rule exception and use the signer as the characteristic: This is not the correct answer. Creating a new rule exception
and using the signer as the characteristic will not prevent the Cortex XDR Agent from blocking execution of a file based on the digital
signer. A rule exception is an exception that you can create to modify the behavior of a specific prevention rule or BIOC rule. A rule
exception allows you to specify the characteristics and the actions that you want to apply to the exception, such as file hash, process
name, IP address, or domain name. However, this method does not support using the signer as a characteristic, and it may not be
applicable to all prevention rules or BIOC rules3.
D . Add the signer to the allow list under the action center page: This is not the correct answer. Adding the signer to the allow list
under the action center page will not prevent the Cortex XDR Agent from blocking execution of a file based on the digital signer.
The action center page is a page that allows you to create and manage actions that you can perform on your endpoints, such as
isolating, scanning, collecting files, or executing scripts. The action center page does not have an option to add a signer to the allow
list, and it is not related to the malware prevention or detection functionality4.
In conclusion, to prevent the Cortex XDR Agent from blocking execution of a file based on the digital signer in Windows and
macOS, one way to add an exception for the signer is to add the signer to the allow list in the malware profile. By using this method,
you can exclude the files that are signed by the trusted signer from the malware scanning and blocking.
Reference:
Add a New Malware Security Profile
Add a New Restrictions Security Profile
Create a Rule Exception
Action Center
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